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Overview 
Stellar DBX to PST Converter converts Microsoft Outlook Express (DBX) files to Microsoft Outlook (PST) 

file. The application scans and converts a single DBX or a complete mailbox with multiple DBX files. After 

scanning, the software shows the preview of mails. 

Key Features of Stellar DBX to PST Converter are as follows: 

• User friendly and secure software. 

• Converts Microsoft Outlook Express (DBX) files to Microsoft Outlook (PST) file. 

• Find feature to search for Microsoft Outlook Express (DBX) files. 

• Provides preview of mails. 

• Log Report. 
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Installation Procedure 
Before installing the software, check that your system meets the following minimum system requirements: 

Minimum System Requirements 

Processor: Pentium Class 

Operating System: Windows 8.1 / Windows 8 / Windows 7 / Windows Vista / Windows XP 

Memory: Minimum 1 GB 

Hard Disc: 100 MB free space 

MS Outlook: 2013 / 2010 / 2007 / 2003 

To install the software, follow these steps: 
1. Double-click StellarDBXtoPSTConverter.exe executable file to start installation. Setup - Stellar 

DBX to PST Converter dialog box is displayed.  

2. Click Next. License Agreement dialog box is displayed. 

3. Choose I accept the agreement option. Next button will be enabled. Click Next. Select 
Destination Location dialog box is displayed. 

4. Click Browse to select the destination path where the setup files will be stored. Click Next. Select 

Start Menu Folder dialog box is displayed. 

5. Click Browse to provide path for program's shortcuts. Click Next. Select Additional Tasks dialog 

box is displayed. 

6. Choose the check boxes as per your choice. Click Next. Ready to Install dialog box is displayed.  

7. Review the entries. Click Back if you want to change them. Click Install to start installation. The 

installation window shows the progress. 

8. After completing the process, Completing the Stellar DBX to PST Converter Setup Wizard 

window is displayed. Click Finish. 

9. Clear Launch Stellar DBX to PST Converter check box to stop automatic launch of software. 

 

Note: Clear Launch Stellar DBX to PST Converter check box before clicking Finish to prevent the 

software from launching. 
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Launching the software 
To launch Stellar DBX to PST Converter in Windows 8.1 / 8: 

• Click Stellar DBX to PST Converter tile on the home screen. On application main screen, select 

Convert DBX to PST icon. 

Or, 

• Double click Stellar DBX to PST Converter on desktop and then select Convert DBX to PST icon 

on the main screen of the application. 

 

To launch Stellar DBX to PST Converter in Windows 7 / Vista / XP: 

• Click Start -> Programs -> Stellar DBX to PST Converter -> Convert DBX to PST. 

Or, 

• Double click Stellar DBX to PST Converter on desktop and then select Convert DBX to PST icon 

on the main screen of the application.  

Or, 

• Click on Stellar DBX to PST Converter in Quick Launch. On application main screen, select 

Convert DBX to PST icon. 
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Main User Interface 

Stellar DBX to PST Converter software has a very easy to use Graphical User Interface. The user 

interface contains features required for conversion. 

After launching the program, you will see the main user interface as shown below: 

 

The user interface contains menus and buttons that lets you access various features of the software with 

ease. 
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Menus 
File Menu 

 

Select DBX 

Use this option to select .DBX file, identity 

folder. 

 

Save 

Use this option to save converted mails 

after scanning. 

View Menu 

 

Log Report 

Use this option to view the log window. 

Tools Menu 

 

Update Wizard 

Use this option to update your copy of 

Stellar DBX to PST Converter. 

Registration Menu 

 

Register 

Use this option to register your copy of 

the software. 

Help Menu 



7 

 

Help Topics 

Use this option to see user help guide. 

 

Order 
Use this option to buy Stellar DBX to 
PST Converter. 

 

Support 

Use this option to view support page of 

stellarinfo.com. 

 

Knowledgebase 

Use this option to view knowledgebase 

articles of stellarinfo.com. 

 

Enquiry 

Use this option to submit enquiry to 

stellarinfo.com. 

 

About 

Use this option to read information about 

the software. 

Style Menu 

 

Style 

Use this option to switch between various themes 

for the software, as per your choice. Stellar DBX 
to PST Converter offers the following themes: 

Blue Style, Black Style, Silver Style and Aqua 
Style. 
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Buttons 
The user interface of Stellar DBX to PST Converter has the following buttons: 

 

Select DBX 

 

Click this button to open Select DBX File dialog box. 

 

Save 

 

After scanning, click this button to go through the process of saving converted 

mails. 

 

Support 

 

Click this button to open Stellar Information Technology Private Limited's online 

support website. 

 

Help 

 

Click this button to access user guide if you face any issue while using the 

product. 

 

Knowledgebase 

 

Click this button to view knowledgebase articles of stellarinfo.com 

 

Enquiry 

 

Click this button to submit an enquiry to stellarinfo.com 

 

Log Report 

 

Click this button to view the log report, which contains the details of the 

conversion process. 
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Register 

 

Click this button to register the software after purchasing. 

 

Update Wizard 

 

Click this button to check for both latest minor and major version available 

online. 

 

Order 

 

Click this button to go through the purchasing process. 

 

About 

 

Click this button to know the version of the software, operating system it 

supports, service pack number of the operating system, etc. 
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How to Order 
To know more about Stellar DBX to PST Converter, click here. 

To purchase the software online, please visit http://www.stellarinfo.com/email-repair/dbx-pst-

converter/buy-now.php 

Select either of the methods given above to purchase the software. 

Once the order is confirmed, a serial number will be sent to you through e-mail, which would be required 

to activate the software. 

 

 

 

  

http://www.stellarinfo.com/email-repair/dbx-pst-converter.php
http://www.stellarinfo.com/email-repair/dbx-pst-converter/buy-now.php
http://www.stellarinfo.com/email-repair/dbx-pst-converter/buy-now.php


11 

How to Register 
The demo version of Stellar DBX to PST Converter can be downloaded from the Stellar website. This 

demo version is just for evaluation purpose and must be eventually registered to use the full functionality 

of the software. Software can be registered after receiving the key. 

To register the demo application, follow the steps given below: 
1. Select Activate Stellar DBX to PST Converter in Registration menu. Activation dialog box is 

displayed. 

2. If you have the registration key, select I have a Registration Key and click OK. Stellar DBX to 
PST Converter dialog box is displayed. 

 

3. Enter the User Name, Activation Code and then click OK to activate the software. 

 

4. If you don't have the registration key, select I do not have the registration key and click OK to 

purchase the software online. 
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How to Update 
There are periodical software updates for Stellar DBX to PST Converter. The software updates should 

be done to keep the software up-to-date. The updates can be a newly added functionality, a new feature, 

a new service or any other information that can be important for improvement. Update option in the 

application is capable of checking for the latest updates. This will check for both latest minor and major 

version available online. You can easily download minor version through the update wizard. However, the 

major version, if available, has to be purchased. While updating the software, it’s recommended to close 

all the running programs. Note that demo version can not be updated. 

To update the application, follow the steps given below: 
1. Click on Update Wizard button from the Tools menu bar. Update Wizard is displayed. 

2. Click Next. A busy timer shows that updates are being searched. If it finds any new version, a 

message indicates the availability. 

3. If a message is displayed that no updates are available, click Cancel to close the wizard. 

4. Click Next. The software will start downloading the update files from the server. When the 

process is complete, the software will upgrade to the latest version.  
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Stellar Support 
Our Technical Support professionals will give solutions for all your queries related to Stellar products. 

You can either call us or go online to our support section at http://stellarinfo.com/support/ 

For price details and to place the order, click http://www.stellarinfo.com/email-repair/dbx-pst-

converter/buy-now.php 

Chat Live with an Online technician at http://stellarinfo.com/support/ 

Search in our extensive Knowledgebase at http://www.stellarinfo.com/support/kb 

Submit enquiry at http://www.stellarinfo.com/support/enquiry.php 

Send e-mail to Stellar Support at support@stellarinfo.com 

Support Helpline 

Monday to Friday [ 24 Hours a day ] 

USA (Toll free Pre Sales Queries) +1-877-778-6087 

USA (Post Sales Queries) +1-732-584-2700 

UK (Europe) +44-203-026-5337 

Australia & Asia Pacific +61-280-149-899 

Netherlands Pre & Post Sales Support +31-208-111-188 

Worldwide +91-124-432-6777 

Skype Id stellarsupport 

Email Orders   orders@stellarinfo.com 

  

http://www.stellarinfo.com/support/
http://www.stellarinfo.com/email-repair/dbx-pst-converter/buy-now.php
http://www.stellarinfo.com/email-repair/dbx-pst-converter/buy-now.php
http://www.stellarinfo.com/support/
http://www.stellarinfo.com/support/kb/
http://www.stellarinfo.com/support/enquiry.php
mailto:support@stellarinfo.com?
mailto:orders@stellarinfo.com?subject=Purchase%20Order
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Convert Entire Mailbox to PST File 
To covert an entire mailbox to PST file, follow the steps given below: 

1. Choose Convert / Migrate entire mailbox to MS Outlook PST in Select DBX File dialog box as 

shown below: 

 

2. Select DBX File dialog box is opened when you  

i. Launch the application. 

ii. Choose Open DBX File option from the File menu. 

iii. Click Open DBX File button on the toolbar. 

3. Click on Select Identity Folder button from the Select DBX File dialog box and locate identity 

folder in Browse dialog box. The software will display the list of DBX files found in the identity 

folder as shown below: 
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4. Click Start Conversion button to start the scanning process. 

Note: The default location of Identity Folder on Windows XP system is -> C:\Documents and 

Settings\Administrator\Local Settings\Application Data\Identities\Microsoft..... 
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Convert Single DBX file to PST file 
To convert a single DBX file to a PST file, follow the steps given below: 

1. Choose Convert / Migrate single DBX file to MS Outlook PST in Select DBX File dialog box 

as shown below: 

 

2. Select DBX File dialog box is opened when you 

i. Launch the application. 

ii. Choose Open DBX File option from the File menu. 

iii. Click Open DBX File button on the toolbar. 

3. Click Select DBX button and locate DBX file in Open dialog box. After selection, Start 
Conversion button is enabled. 

4. Click Start Conversion button to start the scanning process. 
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Find DBX Files 
To search for DBX files on your computer, you can use the Find DBX button. 

To search for DBX files on your computer, follow the steps given below: 
1. Click Find DBX button in Select DBX File dialog box. The Find DBX dialog box opens as shown 

below: 

 

2. Select drive to be searched for DBX files in Look in drop down box and click Start button. The 

application starts searching for DBX files and displays list of files found after finishing the search. 

3. Select the desired DBX file and click OK. 

4. Click Start Conversion button in Select DBX File dialog box to start conversion process. 
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Preview Mails 
After scanning is completed successfully, the application displays mailbox folders in left pane of the user 

interface. Click on any folder to see its mails in upper right pane. To see content of desired mail, click on it 

in upper right pane. The content is displayed in lower right pane as shown below. 
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Save Converted File 
To save the converted mails, follow the steps given below: 

1. Click on the desired mail item folder in the left pane to select it. 

2. Click on Save Mails button on the toolbar or select Save Mails option from File menu. 

3. Save File Option dialog box will open as shown below. 

 

4. To append the converted mails to an existing MS Outlook profile, follow the steps given below: 

i. By default, Append data to existing profile radio option is selected and all MS Outlook 

profiles are displayed. You can select any one of them. 

ii. Click OK. 

The converted mails will be added to the existing MS Outlook profile. 

Or, 

4. To save converted mails to a new PST file, follow the steps given below: 

i. Select Create New PST File and click Browse button. 

ii. Browse For Folder dialog box opens. Select location for saving PST file and click OK. 
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iii. Click OK. 

The converted mails will be saved into a new PST file at the specified location. 

Or, 

4. To save converted mails to an existing PST file, follow the steps given below: 

i. Select Save Data to existing PST File and click on Browse button. 

ii. Browse For Folder dialog box opens. Select an existing PST file in Open dialog box. 

Click Open. 

iii. Click OK. 

The converted mails will be saved into the selected PST file. 

 

Note: In demo version of the software, you can only view and save the subject and body of the mails but 

cannot open any of the mail's attachments. All other fields have DEMO written in it. 
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Import PST File in MS Outlook 
To import PST file in Microsoft Outlook 2010 / 2013: 

1. Open Microsoft Outlook from File menu, select Open -> Import. (For MS Outlook 2013, select 

Open and Import from File menu). 

2. From Import and Export Wizard window, select Import from another program or file, click 

Next. 

3. In Import a File dialog box, select Outlook Data File (.PST), click Next. 

4. Click Browse to locate the PST file that needs to be imported. In the options box, select an 

appropriate option. Click Next. 

5. In Import Outlook Data File dialog box, select the folders that should be imported in Microsoft 

Outlook. Click Finish. 

To import PST file in Microsoft Outlook 2007 / 2003: 

1. Open Microsoft Outlook. From File menu, select Import and Export. 

2. From Import and Export Wizard window, select Import from another program or file, click 

Next. 

3. In Import a File dialog box, select Personal Folder File (PST), click Next. 

4. Click Browse to locate the PST file that needs to be imported. In the options box, select an 

appropriate option. Click Next. 

5. In Import Personal Folders dialog box, select the folders that should be imported in Microsoft 

Outlook. Click Finish. 
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Save Log Report 
Log Report window displays the log from the beginning of the process to its end along with other 

information like name of file etc. during running of the process. With Stellar DBX to PST Converter, you 

can save the Log Report to analyze the process at a later stage. 

 

To save the log details: 
1. Click on View menu. Select Log Report option. 

2. From Log Report dialog box, click on Save Log option. 

3. Browse for location in Save As dialog box to save the log report at a desired location. Click OK. 

To clear the log details: 
1. Click on View menu. Select Log Report option. 

2. From Log Report dialog box, click on Clear Log option. 
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FAQs 
1. What does the demo version of the software do? 

In demo version of the software, you can only view and save the subject and body of the mails 

but cannot open any of the mail's attachments. All other fields have DEMO written in it. To view / 

save all data and open attachments, you need to purchase and register the software. 

2. Can I convert a single mail into PST file? 

No. 

3. Can Stellar DBX to PST Converter search for a DBX file location of which is unknown to 
me? 

Yes, you can search for DBX file using Find option present in Select DBX File dialog box. for full 

detail, please refer to Find DBX Files topic of this help. 

4. I want to save converted mails into an existing PST file. How can I do it? 

Stellar DBX to PST Converter gives you option to save converted mails into an existing or new 

PST file. For full details, please refer to Save Converted File topic of this help manual. 

5. Can I convert multiple DBX files simultaneously? 

Yes. But multiple DBX files should be in a single identity folder. Then you can select this identity 

folder for conversion. 

6. Can I convert multiple Identity Folders simultaneously? 

No. 

7. What is the default location of DBX file on my Windows XP system? 

The default location of DBX file on Windows XP system is -> C:\Documents and 
Settings\Administrator\Local Settings\Application Data\Identities\..... 

8. Can I save converted mails to a password protected PST File? 

Yes, absolutely. You can now save converted mails to a password protected PST file using 

Stellar DBX to PST Converter software. By selecting Append data to existing profile / Save 
Data to an existing PST file, you can add data to a password protected PST file as well, by 

simply entering the password when prompted. 
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Legal Notices 
Copyright 

Stellar DBX to PST Converter software, accompanied user manual and documentation are copyright of 

Stellar Information Technology Private Limited, with all rights reserved. Under the copyright laws, this 

user manual cannot be reproduced in any form without the prior written permission of Stellar Information 

Technology Private Limited. No Patent Liability is assumed, however, with respect to the use of the 

information contained herein. 

Copyright © Stellar Information Technology Private Limited. INDIA. 

Disclaimer 

The Information contained in this manual, including but not limited to any product specifications, is subject 

to change without notice. 

STELLAR INFORMATION TECHNOLOGY PRIVATE LIMITED PROVIDES NO WARRANTY WITH 
REGARD TO THIS MANUAL OR ANY OTHER INFORMATION CONTAINED HEREIN AND HEREBY 
EXPRESSLY DISCLAIMS ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR 
ANY PARTICULAR PURPOSE WITH REGARD TO ANY OF THE FOREGOING STELLAR 
INFORMATION TECHNOLOGY PRIVATE LIMITED ASSUMES NO LIABILITY FOR ANY DAMAGES 
INCURRED DIRECTLY OR INDIRECTLY FROM ANY TECHNICAL OR TYPOGRAPHICAL ERRORS 
OR OMISSIONS CONTAINED HEREIN OR FOR DISCREPANCIES BETWEEN THE PRODUCT AND 
THE MANUAL. IN NO EVENT SHALL STELLAR INFORMATION TECHNOLOGY PRIVATE LIMITED, 
BE LIABLE FOR ANY INCIDENTAL, CONSEQUENTIAL SPECIAL, OR EXEMPLARY DAMAGES, 
WHETHER BASED ON TORT, CONTRACT OR OTHERWISE, ARISING OUT OF OR IN CONNECTION 
WITH THIS MANUAL OR ANY OTHER INFORMATION CONTAINED HEREIN OR THE USE 
THEREOF. 

Trademarks 

Stellar DBX to PST Converter® is a registered trademark of Stellar Information Technology Private 

Limited.  

Windows XP®, Windows Vista®, Windows 7® and Windows 8® are registered trademarks of Microsoft® 

Corporation Inc. 

MS Outlook Express® and MS Outlook® are registered trademarks of Microsoft® Corporation Inc. 

All Trademarks Acknowledged. 
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All other brands and product names are trademarks or registered trademarks of their respective 

companies. 

License Agreement 

Stellar DBX to PST Converter 

Copyright © Stellar Information Technology Private Limited. INDIA. 

www.stellarinfo.com 
All rights reserved. 
All product names mentioned herein are the trademarks of their respective owners. 
This license applies to the standard-licensed version of Stellar DBX to PST Converter. 

Your Agreement to this License 

You should carefully read the following terms and conditions before using, installing or distributing this 

software, unless you have a different license agreement signed by Stellar Information Technology Private 

Limited. 

If you do not agree to all of the terms and conditions of this License then do not copy, install, distribute or 

use any copy of Stellar DBX to PST Converter with which this License is included, you may return the 

complete package unused without requesting an activation key within 30 days after purchase for a full 

refund of your payment. 

The terms and conditions of this License describe the permitted use and users of each Licensed Copy of 

Stellar DBX to PST Converter. For purposes of this License, 

if you have a valid single-user license, you have the right to use a single Licensed Copy of Stellar DBX to 

PST Converter. If you or your organization has a valid multi-user license, then you or your organization 

has the right to use up to a number of Licensed Copies of Stellar DBX to PST Converter equal to the 

number of copies indicated in the documents issued by Stellar Information Technology Private Limited 

when granting the license. 

Scope of License 

Each Licensed Copy of Stellar DBX to PST Converter may either be used by a single person or used 

non-simultaneously by multiple people who use the software personally installed on a single workstation. 

This is not a concurrent use license. 

All rights of any kind in Stellar DBX to PST Converter, which are not expressly granted in this license, are 

entirely and exclusively reserved to and by Stellar Information Technology Private Limited. You may not 

rent, lease, modify, translate, reverse engineer, de-compile, disassemble or create derivative works 

based on Stellar DBX to PST Converter nor permit anyone else to do so. You may not make access to 

http://www.stellarinfo.com/
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Stellar DBX to PST Converter available to others in connection with a service bureau, application service 

provider or similar business nor permit anyone else to do so. 

Warranty Disclaimers and Liability Limitations 

Stellar DBX to PST Converter and all accompanying software, files, data and materials are distributed 

and provided AS IS and with no warranties of any kind, whether expressed or implied. You acknowledge 

that good data processing procedure dictates that any program including Stellar DBX to PST Converter 

must be thoroughly tested with non-critical data before there is any reliance on it and you hereby assume 

the entire risk of all use of the copies of Stellar DBX to PST Converter covered by this License. This 

disclaimer of warranty constitutes an essential part of this License. 

In addition, in no event does Stellar Information Technology Private Limited authorize you or anyone else 

to use Stellar DBX to PST Converter in applications or systems where its failure to perform can 

reasonably be expected to result in a significant physical injury or in loss of life. Any such use is entirely at 

your own risk and you agree to hold Stellar Information Technology Private Limited harmless from any 

and all claims or losses relating to such unauthorized use. 

In no event shall Stellar Information Technology Private Limited or its suppliers be liable for any special, 

incidental, indirect, or consequential damages whatsoever (including, without limitation, damages for loss 

of business profits, business interruption, loss of business information, or any other pecuniary loss) 

arising out of the use of or inability to use the software product or the provision of or failure to provide 

support services, even if Stellar Information Technology Private Limited has been advised of the 

possibility of such damages. In any case, Stellar Information Technology Private Limited’s entire liability 

under any provision shall be limited to the amount actually paid by you for the software product. 

General 

This License is the complete statement of the agreement between the parties on the subject matter and 

merges and supersedes all other or prior understandings, purchase orders, agreements and 

arrangements. This License shall be governed by the laws of the State of Delhi, India. Exclusive 

jurisdiction and venue for all matters relating to this License shall be in courts and fora located in the 

State of Delhi, India and you consent to such jurisdiction and venue. There are no third party beneficiaries 

of any promises, obligations or representations made by Stellar Information Technology Private Limited 

herein. Any waiver by Stellar Information Technology Private Limited of any violation of this License by 

you shall not constitute nor contribute to a waiver by Stellar Information Technology Private Limited of any 

other or future violation of the same provision or any other provision of this License. 

Copyright © Stellar Information Technology Private Limited. INDIA. 
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About Stellar 
Stellar Information Technology Private Limited is a trusted name in the field of Data Recovery and Data 

Protection Software for more than a decade. 

We provide the widest range of Data Recovery Products. Our range includes Data Recovery Software for 

almost all Operating Systems and File Systems. 

Product line: 

Data Recovery 

A widest range of data recovery software that helps you recover your valued data lost after accidental 

format, virus problems, software malfunction, file/directory deletion, or even sabotage!. More Info >> 

File Recovery 

The most comprehensive range of file undelete and unerase software for Windows and MS office repair 

tools. More Info >> 

E-mail Recovery 

A wide range of mail recovery, mail repair and mail conversion applications for MS Outlook, MS Outlook 

Express and MS Exchange useful in instances of data loss due to damages and corruption of E-mail. 

More Info >> 

Data Protection 

A wide range of Prevent Data Loss, Data backup and Hard Drive Monitoring Applications to ensure 

complete data protection against hard drive crash. More Info >> 

Data Sanitization 

Data cleanup and file eraser utility can delete selected folders, groups of files, entire logical drives, 

System Traces & Internet traces. Once the data have been removed using Stellar Wipe - Data File eraser 

utility, it is beyond recovery limits of any Data Recovery Software or utility. More Info >> 

 

For more information about us, please visit www.stellarinfo.com 

 

http://www.stellarinfo.com/disk-recovery.htm
http://www.stellarinfo.com/undelete.htm
http://www.stellarinfo.com/mail-recovery.htm
http://www.stellarinfo.com/prevent-dataloss.htm
http://www.stellarinfo.com/file-eraser.htm
http://www.stellarinfo.com/
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